Morningstar Direct Training Guide
Creating Searches in Morningstar Direct
Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
<td>5</td>
</tr>
<tr>
<td>What is the difference between a search and a list?</td>
<td>6</td>
</tr>
<tr>
<td>How do searches differ in various parts of Morningstar Direct?</td>
<td>6</td>
</tr>
<tr>
<td>Working with Simple Searches</td>
<td>8</td>
</tr>
<tr>
<td>Overview</td>
<td>8</td>
</tr>
<tr>
<td>Should I create a search to look for investments by name or ticker symbol?</td>
<td>8</td>
</tr>
<tr>
<td>Exercise 1: Create a search from the Local Databases module</td>
<td>9</td>
</tr>
<tr>
<td>Exercise 2: Save a search</td>
<td>12</td>
</tr>
<tr>
<td>Exercise 3: Reset a universe after conducting a search</td>
<td>13</td>
</tr>
<tr>
<td>Exercise 4: Open a saved search</td>
<td>14</td>
</tr>
<tr>
<td>Exercise 5: Create a simple search with multiple criteria</td>
<td>16</td>
</tr>
<tr>
<td>Exercise 6: Expand your search to another category</td>
<td>19</td>
</tr>
<tr>
<td>Exercise 7: Look for a field by name</td>
<td>22</td>
</tr>
<tr>
<td>Exercise 8: Update your user preferences to find the cheapest share class of a fund</td>
<td>24</td>
</tr>
<tr>
<td>Exercise 9: Create a search by criteria in the Workspace module</td>
<td>26</td>
</tr>
<tr>
<td>Final lessons on creating simple searches</td>
<td>28</td>
</tr>
<tr>
<td>Creating Complex Searches</td>
<td>29</td>
</tr>
<tr>
<td>Overview</td>
<td>29</td>
</tr>
<tr>
<td>Exercise 10: Create a search across multiple Morningstar categories</td>
<td>29</td>
</tr>
<tr>
<td>Exercise 11: Create two searches at once</td>
<td>35</td>
</tr>
<tr>
<td>Final lessons on creating advanced searches</td>
<td>37</td>
</tr>
<tr>
<td>Additional Practice Exercises</td>
<td>38</td>
</tr>
<tr>
<td>Overview</td>
<td>38</td>
</tr>
<tr>
<td>Exercise 12: Find passively managed funds in a Morningstar Category</td>
<td>38</td>
</tr>
<tr>
<td>Exercise 13: Find the annual return values for Morningstar Stock Sector indexes</td>
<td>38</td>
</tr>
<tr>
<td>Exercise 14: Find socially responsible separate accounts and CITs</td>
<td>39</td>
</tr>
<tr>
<td>Solution to Exercise 12</td>
<td>40</td>
</tr>
<tr>
<td>Solution to Exercise 13</td>
<td>41</td>
</tr>
<tr>
<td>Solution to Exercise 14</td>
<td>46</td>
</tr>
</tbody>
</table>
Creating Searches in Morningstar Direct℠

What do you do in Morningstar Direct℠ when you need to create a set of securities with certain characteristics, such as funds belonging to a specific Morningstar category, or those with an expense ratio below a particular threshold, or stocks in an industry that also have a P/E ratio below a certain number?

The Search function in Morningstar Direct is the solution to this problem. The Search by Criteria window returns a set of investments currently matching whatever criteria you define.

Note: Prior to using this training guide, you should be familiar with the content in the Quick Start Guide for Morningstar Direct. Also, this guide builds on the exercises offered in Working with Investment Lists in Morningstar Direct.
What is the difference between a search and a list?

If a search returns a set of investments, and a list is also a set of investments in Morningstar Direct, then what is the difference between the two approaches?

A search offers dynamic results each time it is run. For example, if you search for five-star, open-end funds in the Large Value category, you might find 145 funds today, but the specific funds you see could (and likely will) change from month to month (because the Morningstar Rating is updated monthly).

An investment list, however, is static and the items on a list do not change unless you manually add or remove members to/from the list. In other words, you could save the 145 five-star Large Value funds from your search results to a list, and that list will not change unless you add items to it, or remove items from it. To learn more about creating lists, see Working with Investment Lists in Morningstar Direct.

How do searches differ in various parts of Morningstar Direct?

You can create searches (or retrieve saved searches) from the following modules in Morningstar Direct:

- Local Databases
- Global Databases
- Performance Reporting
- Portfolio Management
- Portfolio Analysis
- Workspace

Which part of Morningstar Direct you create a search from depends, in part, on what you need to search for in order to complete a task. For example, if you need to search among only one type of investment, such as open-end funds for sale in your country, you can create that search from the Local Databases module.
However, if you need to create a search that considers both open-end funds and exchange-traded funds, you could go to the Workspace or Performance Reporting module to complete that search.

Finally, if your ultimate goal is not simply to generate a set of results from a search, but to analyze the results, you would create the search from the Performance Reporting module.

In the exercises that follow, you will see examples of the advantages and possible limitations of a search created in each area of Morningstar Direct.
Working with Simple Searches

In a sense, all searches are created equal. No matter how many criteria you select or how they are ordered in the Search by Criteria window, each search requires you to do the following:

- Select a field name (i.e., a data point) to evaluate
- Choose an operator (=, <, >, etc.) for the field’s value, and
- Assign a value to the field; this could be a number or a text label.

For example, a very basic search to find funds in the Large Value category would use the following criteria:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morningstar Category</td>
<td>=</td>
<td>Large Value</td>
</tr>
</tbody>
</table>

A search to find funds whose annual net expense ratio is less than or equal to 1.25% would look use the following criteria:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annual Net Expense Ratio</td>
<td>&lt;=</td>
<td>1.25</td>
</tr>
</tbody>
</table>

In this section, you will practice creating some relatively simple searches, and learn how to save and retrieve the searches you create as well.

In a word, no. While you can use the Search by Criteria window to look for items by name or ticker symbol when you know those values, this action takes an extraordinarily long time to complete. The number of clicks involved is not worth the effort.

Instead, create a list of known investments from the Workspace module. For details on how to create lists, please see the Working with Investment Lists in Morningstar Direct document.
Exercise 1: Create a search from the Local Databases module

When you create a search from the Local Databases module, you are effectively building on a search that already exists. For example, for users in the United States, when the Open End Funds page is selected in the Local Databases module and you click the United States Mutual Funds link (see screen shot after step 2 below), you are viewing a search result screening for open-end funds for sale in the U.S.

In this first exercise, you will look for Large Value U.S. funds. Do the following:

1. From the left-hand navigation pane, select the Local Databases module.
2. Click the Open End Funds page.
3. Click the link for United States Mutual Funds. The database opens.

4. From the toolbar above the spreadsheet view, click the Search icon. The Search by Criteria window opens.
Exercise 1: Create a search from the Local Databases module

5. Click in the **Field Name** cell for the row 1, and select **Morningstar Category**. The Operator cell in the first row defaults to `=`.

6. Click the **Value** cell in the first row. Note that the categories are listed alphabetically.

7. **Scroll** down and click **Large Value**.

8. To preview how many investments meet the criterion, click the **Run Search** button.
9. To view the results of the search in the grid view, click **OK**. In each row, take note of what is shown under the Morningstar Category column, and note the Total: number of investments showing in the bottom-left corner of the grid view.
Exercise 2: Save a search

Saving a search precludes you from having to re-enter the criteria again and again for those searches you use frequently. Once saved, a search is found under the Search Criteria folder from the Workspace tab, or you can open it from the Search window itself in other modules. To save a search, do the following:

1. You should still be in the Open End Funds universe, with United States Mutual Funds showing. From the toolbar above the grid view, click the **Search** icon. The Search by Criteria window opens, and the criterion you entered earlier should still be showing.

2. From the top of the Search by Criteria window, click the **Save As** icon. The Save As dialog box opens.

---

**Exercise 2: Save a search**

Click this icon to re-open the Search by Criteria window

Click this icon to save a search
3. In the **Name** field, type **Large Value**.

4. Click **OK** to close the dialog box.
5. Click **OK** to close the Search by Criteria window. The search you saved can be opened from the Search by Criteria window, or by going to the **Workspace** module and selecting the **My Searches** page.

Creating the search in Exercise 1 changed the data universe (Open End Funds) you selected when you began the exercise. Now, instead of seeing all open end funds, you see only open end funds in the Large Value category. You can reset the universe and return to seeing all open end funds with one click.

From the toolbar above the spreadsheet view, click the name of the universe, in this case: **United States Mutual Funds**.
Exercise 4: Open a saved search

Once saved, a search is found under the Search Criteria folder in the Workspace module. Alternatively, you can also open a saved search from the Search by Criteria window itself anywhere you can access it in another module, such as the Local Databases module.

To open a saved search from the Local Databases module, do the following:

1. You should still be in the United States Mutual Funds universe. From the toolbar above the spreadsheet area, click the Search icon. The Search by Criteria window opens.
2. Click the Open icon. The Open From dialog box opens.
3. Click Large Value, then click OK to close the Open From dialog box.
4. Click OK on the Search by Criteria window to execute the search.
Exercise 4: Open a saved search

To open a saved search from the Workspace module, do the following:

1. From the left-hand navigation pane, select the **Workspace** module.
2. Under the **Search Criteria** folder, select **My Search Criteria**. If you completed the exercises in the Working with Investment Lists in Morningstar Direct guide, you will see the Small Value Funds search you created and saved as part of that work. The Small Value Funds search did not appear in the previous set of steps (where you opened a saved search from the Local Databases module) because the Small Value Funds search considered both Open End Mutual Funds and Exchange-Traded Funds, and the search in the Local Databases module was looking only for Open End Mutual Funds. Therefore, searches including other investment types cannot be seen when opening a search from the Search by Criteria window in the Local Databases (or Global Databases) module.

3. **Double-click** the **Large Value** item to open it. Note that the spreadsheet view opens with the results, without first showing the Search window.
So far, the exercises you have completed have dealt with a search that looked for one criterion only: Large Value funds. In practice, your searches will almost always contain multiple criteria, so let’s explore adding criteria to a search.

When you ran the search for Large Value funds in the Exercise 1, you may have noticed that multiple instances of funds appeared in the results, rather than just a single instance of each fund. To see only one instance of a fund, you have a few options. For instance, you could ask to see only a certain share class of a fund, such as the A share.

However, not all funds have an A share, and using this as an additional criterion could potentially eliminate several funds from the search that you didn’t intend to. Instead, you can use a criterion called Oldest Share Class. This finds only the original share class for each fund included in a search. You will open the search you saved in Exercise 2, and build on it.

Do the following:

1. Select the Local Databases module, and open the United States Mutual Funds universe. From the toolbar above the spreadsheet area, click the Search icon. The Search window opens.
2. Click the Open icon. The Open From dialog box opens.

Use this icon to recall a saved search
3. Click Large Value, then click OK to close the Open From dialog box.

4. In the Search by Criteria window, click Run Search, and take note of the number of items found.

5. Click in the Field Name cell for the second row, and scroll down until you can select Oldest Share Class. The Operator cell in the second row defaults to =.

   Note: As soon as you clicked in the Field Name cell for row 2, the word “And” appeared in the Rel(ationship) column. This means both of these criteria (in rows 1 and 2) must be true in order for a fund to be returned by the search. Also, rather than scrolling down to find a criterion, you could also have typed the word Old, and the cursor would jump to find Oldest Share Class.

6. Click in the Value cell for row 2 and select Yes.

7. Click Run Search again, and note the number of funds that are now found.
8. You now have two criteria in your search for Large Value funds. You can re-save the search to reflect this change. Click the **Save As** icon. The Save As dialog box opens.
9. Under the Existing Searches area, **double-click Large Value**; this populates its value in the Name field.

![Save As Dialog Box]

10. Click **OK**.
11. When the overwrite confirmation message opens, click **OK**. Keep the Search by Criteria window open for the next exercise.
Exercise 6: Expand your search to another category

By default, the Search by Criteria window shows you available search criteria by grouping fields into categories. These categories are identical to the pre-built views available in the Local Databases grid view. If you know which category (or view) a field appears in, it is easy to find that field when you want to include it in a search. Some fields, such as Ticker or Morningstar Rating, appear in more than one search category (and pre-built view).

So far, the two criteria (Morningstar Category and Oldest Share Class) you have used in creating searches have appeared in the default Snapshot category, which is expanded by default when you open the Search by Criteria window. In fact, you might not have even realized the fields were grouped by category in the Search by Criteria window. Seeing fields by category is the default setting when working with the Search by Criteria window.
While seeing the Snapshot category expanded by default is convenient for selecting the most popular fields you may be looking for (which is the intent of the Snapshot view/category), this category does not allow you to access all of the criteria you might need for every search. For example, what if you want to eliminate any funds from your search that are not open to new investors? No criterion exists for “Open to New Investors.” Instead, an alternative approach needs to be taken in order to see these funds. Specifically, you need to look for those instances where funds have not been closed to new investors.

To find funds still open to new investors, do the following:

1. You should have the Search by Criteria window open, with the criteria from the Large Value search still displayed. (If not, open the saved search now.)
2. In row 3, click in the Field Name cell.
   - Note: Again, the word “And” appears in the Rel column for row 3.
3. Scroll up to the top of the Field Name list, and collapse the Snapshot category by clicking once on the icon to the left of its name.
4. Click the icon to the left of the Operations category to expand it.
5. **Scroll down** in the Operations category and click **Closed to New Inv**.

6. In the **Operator** cell for row 3, select **Not =**.

7. In the **Value** cell for row 3, select **Yes**.

8. Click **Run Search**. The number of items found now reflects the inclusion of this additional criterion. Because the Rel(ationship) column for all three rows is “And,” all three criteria must be true for a fund in order for it to be found by the search.

9. Re-save the search again to include this latest change. Click the **Save As** icon. The **Save As** dialog box opens.

10. Under the Existing Searches area, **double-click** **Large Value**, this populates its value in the Name field.

11. Click **OK** to close the Save As dialog box.

12. When the overwrite confirmation message opens, click **OK**. Keep the Search by Criteria window open for the next exercise.
By default, the Search by Criteria window allows you to select criteria based on the category each one is assigned to. This works out fine as long as you know under which category each criterion can be found. What happens when you aren’t sure which category to look in for a criterion? Rather than waste a lot of time expanding, scrolling, and collapsing categories as you look for a field, you can instead see all criteria listed alphabetically, regardless of category.

To look for a field by name, do the following:

1. The Search by Criteria window should still be open, with the criteria from the Large Value search still displayed. (If not, open the saved search now.)
2. In the bottom-left corner of the Search by Criteria window, select the option for **Alphabetically**.

3. In row 4, click in the Field Name cell. All criteria are now listed alphabetically.

   Note: Again, the word “And” appears in the Rel column for row 4.
4. Type **Up**. You are moved down in the list of criteria and land on **Upside Capture Ratio 1 Yr (Mo-End)**. Click **Upside Capture Ratio 1 Yr (Mo-End)**.

5. In the **Operator** cell for row 4, select `>=`.
6. In the **Value** field for row 4, enter **100**. This line now looks for only those funds achieving at least 100% of the upside of the market over the past year.

7. Click **Run Search**.
8. Click the **Save As** icon. The Save As dialog box opens.
9. Under the Existing Searches area, **double-click Large Value**; this populates its value in the **Name** field.
10. Click **OK** to close the Save As dialog box.
11. When the overwrite confirmation message opens, click **OK**. Keep the Search by Criteria window open for the next exercise.
Exercise 8: Update your user preferences to find the cheapest share class of a fund

When creating a search to look for only one instance of a fund, you have the following options:

- You can look for the oldest share class of a fund
- You can look for a specific share class for a fund, such as the A share, or
- You can look for the least expensive share class for a fund.

The first example has already been explored. The second example is achieved simply by selecting the Share Class Type field, and choosing the appropriate value. When conducting a search to look for only the cheapest share class for a fund, however, you need to first set the proper user preference from the File menu because no field exists to search on called “Cheapest Share Class.” Once you set the correct user preference, you can check a special box on the Search by Criteria window to activate it and make it part of a search.

To create a user preference prioritizing the cheapest share class of a fund (over other share classes), do the following:

1. On the menu bar at the top of the Morningstar Direct window, from the File menu, select Set User Preferences. The Set User Preferences window opens.
2. Select the User Defined Primary tab.
3. Select the row for Annual Report Net Expense Ratio, then click the move to top button. (The move to top button displays two up arrows.) This ensures this element takes precedence when conducting a search.
4. Be sure the word Lowest appears in the Choose column.

5. Click OK. In the next exercise, you will learn to leverage this setting.
In this exercise, you will search for those large growth funds (both open-end funds and ETFs) meeting the following criteria:

- an expense ratio below the category average
- still open to new investors
- an above-average Sharpe Ratio for the trailing five-year period, when compared to their category peers
- a Downside Capture Ratio below 100 for the five-year period, and
- have been around for at least five years.

Because you are looking for both open end funds and exchange-traded funds at once, this search should be created from the Workspace module, where you can look across both universes simultaneously. Additionally, you will see the following exercise use a checkbox on the Search by Criteria window that heretofore has not been used.

To create this search in the Workspace module, do the following:

1. In Morningstar Direct, select the **Workspace** tab.
2. Under the Search Criteria folder, select **My Search Criteria**.
3. From the toolbar above the grid view, select **New** > **Advanced Search** > **Funds (Open End and Exchange-Traded Funds)**. The Search by Criteria window opens.
4. Set your criteria as shown in the following table. At the bottom of the Search by Criteria window, be sure to check the checkbox for **User Defined Primary Class Only**.

<table>
<thead>
<tr>
<th>Rel</th>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Morningstar Category</td>
<td>=</td>
<td>US Large Growth</td>
</tr>
<tr>
<td>And</td>
<td>Annual Report Net Expense Ratio</td>
<td>&lt;</td>
<td>CAT AVG</td>
</tr>
<tr>
<td>And</td>
<td>Closed to New Inv</td>
<td>Not=</td>
<td>Yes</td>
</tr>
<tr>
<td>And</td>
<td>Sharpe Ratio 5 Yr (Mo-End)</td>
<td>&gt;</td>
<td>CAT AVG</td>
</tr>
<tr>
<td>And</td>
<td>Downside Capture Ratio 5 Yr (Mo-End)</td>
<td>&lt;</td>
<td>100</td>
</tr>
<tr>
<td>And</td>
<td>Inception Date</td>
<td>&lt;=</td>
<td>1/1/2012*</td>
</tr>
</tbody>
</table>

Note: Change this date value to the previous month-end period from five years ago. When using date fields, note that “less than” means “earlier than,” while “greater than” means “later than.”

5. Click **OK**. As you look at the results in the grid view, note that only one instance for each fund is shown, but a variety of share classes are represented.
A simple search uses the same relationship (namely, “And”) between all rows, no matter how many criteria are included in the search. The following are some additional notes to reflect on when creating simple searches:

- Searches can be created in Morningstar Direct from the Local Databases, Global Databases, Workspace, Performance Reporting, and other modules, depending on your needs.
- You can select search criteria fields within a pre-built category, or by seeing them listed alphabetically.
- When looking for a field alphabetically, you can type the beginning of its name to jump to that spot in the list.
- For fields that take a numeric value, such as Annual Report Net Expense Ratio, you can often enter either a number or opt to compare results to the category average.
- Each time you add a criterion to a search, click the Run Search button to ensure you do not end up with 0 results found. If this happens, it indicates a parameter of the search needs to be changed.
- Searches can be saved, to keep you from having to re-enter the same criteria over and over, but remember that the results you see each time you run a saved search could change.
- Saved searches are found under the Workspace module (on the My Searches page), and these saved search files can be shared with or sent to other Morningstar Direct users, just as you can with lists.
- Use the User Defined Primary preference (available from the File menu) to include in your searches an additional layer to eliminate all but one type of share class.
Creating Complex Searches

Thus far, the searches you have created have been fairly simple. Although you have looked for multiple criteria, all of the rows are linked by the “And” relationship. At times, you may need to create a more sophisticated search where the relationship between rows is more complicated and you need to leverage additional capabilities of the Search by Criteria window.

This section covers the following topics:

- using parentheses within the Search by Criteria window to create complex searches
- inserting additional rows into an existing search, and
- monitoring the relationship between rows as you build a complex search.

The search you have created so far searches the Large Value category for the oldest share class of open-end funds still open to new investors and have a 1-year upside capture ratio of at least 100%. What if you want to see funds matching these criteria, not just in the Large Value category, but also in the Large Blend and Large Growth categories? You can do this by building on the search you have saved, rather than creating three separate searches. Do the following:

1. From the left-hand navigation pane, select the Local Databases module.
2. If needed, select the Open End Funds page.
3. Click the link for United States Mutual Funds. The database opens.

Exercise 10: Create a search across multiple Morningstar categories
4. From the toolbar above the spreadsheet view, click the **Search** icon. The Search by Criteria window opens.

5. Click the **Open** icon. The Open From dialog box opens.

---

**Exercise 10: Create a search across multiple Morningstar categories**

**Creating Complex Searches**

4. From the toolbar above the spreadsheet view, click the **Search** icon. The Search by Criteria window opens.

5. Click the **Open** icon. The Open From dialog box opens.
6. Click **Large Value**, then click **OK** to close the Open From dialog box.

7. You are going to insert a new row. An insertion always goes above the row you select. To insert a row between rows 1 and 2, select the **checkbox** to the left of row 2.
Exercise 10: Create a search across multiple Morningstar categories

8. From the toolbar, click the **Insert** icon. A blank row is inserted between rows 1 and 2.

9. In new row (2), click the **Rel** column, then select **Repeat**. The data from the row above is copied into row 2.
10. The Field Name and Operator cells for row 2 should stay the same. Click the Value cell for row 2, and select Large Blend.

11. Repeat steps 6–10 to insert another new row for Large Growth funds.

12. Click Run Search. The number of funds returned seems unexpectedly high. This indicates that you need to encapsulate the first three lines of the search in parentheses, to tell the system to consider them as one object. Otherwise, the system thinks you are looking for any Large Value fund, or any Large Growth fund, or the oldest share class of Large Blend funds still open to new investors with an upside capture ratio of at least 100%.
13. In the { cell of row 1, type {.
14. In the } cell of row 3, type }.

15. Click Run Search. Note the much lower number of funds returned.
16. Save this search as a new item. Click the Save As icon.
17. In the Name field, type Open Large Cap Funds.

18. Click OK to close the Save As dialog box.
19. Click OK to close the Search by Criteria window.
In the last exercise, you saw how to use a set of parentheses to encapsulate a single set of criteria. What if you need to look for two separate sets of data at once? For example, imagine you have been asked to find value-oriented funds with a P/E ratio of no more than 17, and growth-oriented funds that have a P/E ratio of at least 17? This type of search requires multiple instances of parentheses. To create two searches at once, do the following:

1. From the left-hand navigation pane, click the **Workspace** module.
2. Under the **Search Criteria** folder, select **My Search Criteria**.
3. From the toolbar above the grid view, select **New…Advanced Search…Funds (Open End and Exchange Traded Funds)**. The Search by Criteria window opens.

Select this universe to search within

Note the location where the search should be created

---

**Exercise 11: Create two searches at once**
4. **Create** a search with the following criteria:

   Note: Remember to use the **Repeat** option from the **Rel** column to avoid having to select the same field name multiple times. Selecting the **Alphabetically** button in the lower-left corner of the dialog box can help find the criteria more quickly.

<table>
<thead>
<tr>
<th>Rel</th>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Large Value</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Mid-Cap Value</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Small Value</td>
</tr>
<tr>
<td>And</td>
<td>P/E Ratio TTM (Long)</td>
<td>&lt;=</td>
<td>17</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Large Growth</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Mid-Cap Growth</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Small Growth</td>
</tr>
<tr>
<td>And</td>
<td>P/E Ratio (TTM) (Long)</td>
<td>&gt;</td>
<td>17</td>
</tr>
<tr>
<td>And</td>
<td>Oldest Share Class</td>
<td>=</td>
<td>Yes</td>
</tr>
</tbody>
</table>

5. Click the **Run Search** button, to see how many funds match your search.
6. Click the **Save As** icon. The Save As dialog box opens.
7. In the **Name** field, type **Multiple Searches**.
8. Click **OK** to close the Save As dialog box.
9. Click **OK** to close the Search by Criteria window.

   Note: In the search results (seen in the grid view), you can check your work by sorting on the Morningstar Category column (click once on a column’s header to sort by that column), and also by examining the P/E Ratio (TTM) (Long) statistic, which is available from the Equity Port Stats (Long) view.
An advanced search uses relationships (And, Or) between rows, and can also include the use of parentheses. When creating advanced searches, keep in mind the following additional notes:

- When you have the same Field Name for multiple consecutive rows, but a different Value, encapsulate the rows with parentheses, and use “Or” as the Relationship among them. In the row for the next criterion, remember to change the Rel column to “And.”
- Selecting “Repeat” from the Rel column is an easy way to copy data from the row above, and saves you a few clicks from making a selection for every cell in a row.
- You can nest criteria in multiple levels through the proper use of both parentheses and the relationship between rows.
- You can insert rows in the Search by Criteria window; remember that the inserted row appears above the row you have selected.
Additional Practice Exercises

The following exercises provide challenges for you to see how well you can build searches within Morningstar Direct. Answers to each exercise are provided on the following pages.

Exercise 12: Find passively managed funds in a Morningstar Category

How many passively managed open-end funds and ETFs in the Mid-Cap Value category are for sale in the U.S.? Only one instance of each fund needs to be shown. What should the Search by Criteria window look like for this search? The following hints will help you with this exercise:

1. Create the search from the Workspace module.
2. Search within the Funds (Open End and Exchange-Traded Funds) universe.
3. Opt to see the criteria listed alphabetically, and look for a field called “Index Fund.”

Now check your work: Solution to Exercise 12.

Exercise 13: Find the annual return values for Morningstar Stock Sector indexes

Morningstar divides stocks into 11 sectors and three Super Sectors. What are the Total Return 1-Yr (Mo-End) values for the Total Return series of Morningstar Indexes based on the Morningstar Stock Sectors? The following hints will help you with this exercise:

1. The search can be created from the Market Indexes universe under the Local Databases module.
2. The Series Name for the indexes you are searching for is Morningstar US Sector.
3. Total Return indexes can be found by looking for Return Type of Total Return.
4. Note that the search results will encompass the indexes tied to both the Morningstar stock sectors, and the Super Sectors.
5. The one-year return values can be seen from the pre-built Returns (Month-End) view.

Now check your work: Solution to Exercise 13.
How many separate accounts or collective investment trusts (CITs) in the All Cap Core and Flexible Allocation institutional categories self-identify as socially responsible funds?

Note: The Morningstar Institutional Categories were launched in May 2009 in response to feedback from Morningstar’s institutional clients. They felt the Morningstar Categories are typically too broad to support their business processes, such as manager compensation discussions and expense peer grouping. The Morningstar Institutional Categories were developed to address those needs by using more granular definitions to assign portfolios to peer groups. The result is a system with many more categories that more thoroughly identify distinct investment strategies.

The Morningstar Institutional Categories allocate portfolios into peer groups using the same holdings-based methodology already employed by the Morningstar Categories, which were introduced in 1996. The two structures are also parallel in that one category is assigned to each portfolio in Morningstar’s managed funds database. The key difference is that the Institutional Categories have narrower parameters, allowing for more sophisticated and detailed peer group comparisons. This new system is intended to help institutional investors identify true peers, build more thoroughly diversified portfolios, and gain more insight into an individual portfolio’s strategy.

The following hints will help you with this exercise:

1. The search can be created from the Separate Accounts/CITs universe under the Local Databases module.
2. When looking for the All Cap Core and Flexible Allocation category values, be sure to select Morningstar Institutional Category as the Field Name.
3. Remember to use parentheses to enclose multiple criteria that have the same Field Name, but different Values, and use Or as the Rel(ationship).
4. The Socially Responsible criterion can be found under the Strategy Attributes category.

Now check your work: Solution to Exercise 14.
For Exercise 12, the Search by Criteria window should look like the following:

1. From the left-hand navigation pane, click the **Workspace** module.
2. Under the **Search Criteria** folder, select **My Search Criteria**.
3. From the toolbar above the grid view, select **New...Advanced Search...**

**Funds (Open End and Exchange-Traded Funds)**. The Search by Criteria window opens.

Be sure to search within this universe from the **Workspace** module.

Select this universe to search within.
4. **Create** a search with the following criteria:

   Note: Selecting the **Alphabetically** button in the lower-left corner of the dialog box can help find the criteria more quickly.

<table>
<thead>
<tr>
<th>Rel</th>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Morningstar Category</td>
<td>=</td>
<td>U.S. -&gt; Mid-Cap Value</td>
</tr>
<tr>
<td>And</td>
<td>Index Fund</td>
<td>=</td>
<td>Yes</td>
</tr>
<tr>
<td>And</td>
<td>Oldest Share Class</td>
<td>=</td>
<td>Yes</td>
</tr>
</tbody>
</table>

5. Click **OK**.

The search you created for exercise 13 should look like the following:
You should be looking at the following results (the exact market return values you see will differ from those shown):

<table>
<thead>
<tr>
<th>Name</th>
<th>Market Ret % (Mn-End) Base</th>
<th>Market Ret % (Mn-End) Base</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Morningstar US Basic Materials TR USD</td>
<td>5.52</td>
<td>5.52</td>
</tr>
<tr>
<td>2  Morningstar US Common Svc Capped TR USD</td>
<td>11.28</td>
<td></td>
</tr>
<tr>
<td>3  Morningstar US Consumer Cycld TR USD</td>
<td>6.45</td>
<td></td>
</tr>
<tr>
<td>4  Morningstar US Consumer Durable TR USD</td>
<td>2.84</td>
<td></td>
</tr>
<tr>
<td>5  Morningstar US Cycld Sup Sec TR USD</td>
<td>9.27</td>
<td></td>
</tr>
<tr>
<td>6  Morningstar US Diverse Sup Sec TR USD</td>
<td>5.54</td>
<td></td>
</tr>
<tr>
<td>7  Morningstar US Energy Cycld TR USD</td>
<td>3.39</td>
<td></td>
</tr>
<tr>
<td>8  Morningstar US Financial Services TR USD</td>
<td>13.41</td>
<td></td>
</tr>
<tr>
<td>9  Morningstar US Healthcare TR USD</td>
<td>2.99</td>
<td></td>
</tr>
<tr>
<td>10 Morningstar US Industrials TR USD</td>
<td>9.01</td>
<td></td>
</tr>
<tr>
<td>11 Morningstar US Real Estate TR USD</td>
<td>5.10</td>
<td></td>
</tr>
<tr>
<td>12 Morningstar US Sensitive Sup Sec TR USD</td>
<td>0.35</td>
<td></td>
</tr>
<tr>
<td>13 Morningstar US Technology TR USD</td>
<td>11.60</td>
<td></td>
</tr>
<tr>
<td>14 Morningstar US Utilities TR USD</td>
<td>10.99</td>
<td></td>
</tr>
</tbody>
</table>

Note the view to select to see the return values.
Note the values in this column.
To see these same results, do the following:

1. In the left-hand navigation pane, select the **Local Databases** module.
2. Click the **Market Indexes** page.
3. Under the Morningstar-defined Universes list, click the **Global Indexes in USD** universe.
4. From the toolbar above the grid view, click the **Search** icon. The search by criteria window opens.

5. **Create** a search with the following criteria:

<table>
<thead>
<tr>
<th>Rel</th>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>Series Name</td>
<td>=</td>
<td>Morningstar US Sector</td>
</tr>
<tr>
<td>And</td>
<td>Return Type</td>
<td>=</td>
<td>Total Return</td>
</tr>
</tbody>
</table>
6. From the **View** drop-down field, select **Returns (Month End)**. Scroll right to see the values in the Total Return 1 Yr (Mo-End) column.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Return Date</th>
<th>Total Return 1 Yr (Mo-End)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morningstar US Basic Materials TR USD</td>
<td>2/28/2017</td>
<td>33.33</td>
</tr>
<tr>
<td>Morningstar US Consumer Cyclical TR USD</td>
<td>2/28/2017</td>
<td>21.95</td>
</tr>
<tr>
<td>Morningstar US Consumer Discretionary TR</td>
<td>2/28/2017</td>
<td>18.37</td>
</tr>
<tr>
<td>Morningstar US Healthcare TR USD</td>
<td>2/28/2017</td>
<td>12.37</td>
</tr>
<tr>
<td>Morningstar US Consumer Discretionary TR</td>
<td>2/28/2017</td>
<td>39.63</td>
</tr>
<tr>
<td>Morningstar US Energy Capped TR USD</td>
<td>2/28/2017</td>
<td>14.69</td>
</tr>
<tr>
<td>Morningstar US Financial Services TR USD</td>
<td>2/28/2017</td>
<td>25.54</td>
</tr>
<tr>
<td>Morningstar US Healthcare TR USD</td>
<td>2/28/2017</td>
<td>17.84</td>
</tr>
<tr>
<td>Morningstar US Consumer Discretionary TR</td>
<td>2/28/2017</td>
<td>34.45</td>
</tr>
</tbody>
</table>
```

Note the view to select to see the return values. Note the values in this column.
The search you created for exercise 14 should look like the following:

1. In the left-hand navigation pane, select the Local Databases module.
2. Click the Separate Accounts/CITs page.
3. Under the Morningstar-defined Universes list, click the United States Separate Accounts/CITs universe.

To see these same results, do the following:

1. In the left-hand navigation pane, select the Local Databases module.
2. Click the Separate Accounts/CITs page.
3. Under the Morningstar-defined Universes list, click the United States Separate Accounts/CITs universe.
4. From the toolbar above the grid view, click the **Search** icon. The Search by Criteria window opens.
5. Create a search with the following criteria:

<table>
<thead>
<tr>
<th>Rel</th>
<th>Field Name</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>Morningstar Institutional Category</td>
<td>=</td>
<td>All Cap Core</td>
</tr>
<tr>
<td>Or</td>
<td>Morningstar Institutional Category</td>
<td>=</td>
<td>Flexible Allocation</td>
</tr>
<tr>
<td>And</td>
<td>Socially Responsible</td>
<td>=</td>
<td>Yes</td>
</tr>
</tbody>
</table>

6. Click **Run Search** to preview the number of investments that met the search criteria.
7. Click **OK** to view the investments that meet the search criteria.